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A letter direct from the editor desk highlighting on October edition 

Hello Folks! The Christmas is approaching nearby and all are in festive mood. Due to some technical 
problems our publication has been delayed to some extent. We are publishing the October issue of 
sketchup-ur-space magazine. The number of subscribers to our magazine is increasing at an alarming 
rate. We are also getting huge likes for the social media pages of our magazine. This gives us strength to 
make our magazine more appealing to the worldwide Sketchup users. 

We know the sketchup is a most useful tool for architects. It can facilitate the architects from the initial 
stages of schematic design to the completion of construction administration. With the layout features, the 
architects can illustrate plans, elevations, sections, details, specifications, title blocks as well as other 
graphics. In this issue, we are presenting a cover story focusing on some other most recognized web 
based applications expect Sketchup which provides huge benefits to architects to present their ideas in the 
real world. The cover story is written by James Taylor-Foster, President of the Manchester Student Society 
of Architecture and a Contributing Editor at ArchDaily. 

In interview section, the team of sketchup ur space has arranged an interview with Adriana Granados, well 
known independent writer and author of Google Sketchup for Interior Design and Space Planning. In this 
interview, Adriana Granados explains briefly how she gets hooked with Sketchup and selects it as her 
favorite topic for writing several books. She also analyzes how Sketchup is useful for interior design and 
space planning. 

The article section of the magazine is enriched with two informative articles. The first one is written by 
Andrew Campbell and Mark Lancelott and the second is written by Andrew Campbell. Andrew Campbell is 
a Director of Ashridge Business School in the UK and runs executive courses such as Designing Operating 
Models and Advanced Organization Design. He has written more than 10 books on business strategy and 
organization. In the first article Mr. Campbell describes how strategic planning plays an important role for 
an architect. In the second article the readers can learn how to transform business strategy into design 
principles by explaining capabilities. 

In tutorial section there are three exclusive tutorials. The first tutorial is created by Mark Lester Ocampo, 
the most promising Designer / 3D Visualizer from Bahrain. In this tutorial Mark shows how he applies 
Sketchup, 3dsMax+Vray & Photoshop to make modeling, texturing, lighting and rendering of a kitchen. 

In the second tutorial Furloy describes step-by-step processes for making a 3D model of a halfpipe with 
Sketchup. 

In the last and final tutorial James Meier presents an exclusive video tutorial demonstrating how to create 
shapes in Sketchup 8 by applying ‘follow me’ tool. 

In blog section the team of team of sketchup ur space, has provided an exclusive presentation on 
sketchup and augmented reality. Besides, there will be another write up on Sefaira sketchup plugin and 
how it helps architect to make real-time energy analysis as well as high performance building design. 

In blog section E-on Software provides an unique press release highlighting the immediate avalability of 
Vue 2014 xStream and Infinite, the latest and greatest generation of Vue products for CG Professionals. In 
news section our readers can some exciting news on Sketchup and other latest 3d modeling softwares. 

Hope our readers will enjoy this issue as usual. 

If you have any queries concerning publication, subscription, troubles navigating the site, 
please mail us at rajib@sketchup-ur-space.com 

 

Best wishes  
Rajib Dey 

Editor 

mailto:rajib@sketchup-ur-space.com�
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Interview Claudio Feldman - architect since 1984, from Buenos Aires 
University, Argentine 

Hello! Welcome to the arena of Sketchup. Tell us a bit about yourself and your profession. 

I have a unique international background that had impacted in many way my life and profession. I was 
born in Argentina, from a German mother, a father born in Spain and grandparents from France, and 
Germany. After I got my degrees in architecture and interior design in Argentina I completed doctorate 
courses in Barcelona and moved to Colombia where my three children were born. Seven year ago we 
moved to the United States where we reside now. I had the chance to visit half of the globe nurturing my 
passion for design and allowing me to embrace other people cultures and thinking. Diversity is the word 
that applies to my believes, my mind, my heart and my work. I am always thinking on new ways to do 
things. I guess that I am a design thinker blending always my skills as a designer, an entrepreneur, 
instructor, and my social responsibility feelings. 

Writing is your passion. How did you get hooked on writing? Why did you choose sketchup for 
your favorite writing topic? 

Actually writing in not my real passion but a mean to share my knowledge with others. I believe that by 
schooling people and helping others designers to deliver their skills, we can aspire to make the world more 
accessible, more beautiful, and more meaningful. I learned English when I got to the USA and writing was 
a way of having more time to express my thoughts and deliver my knowledge instead of using my limited 
oral skills. I had the chance to be the dealer in South America for different CAD software. I started with a 
great 3D BIM program in 1995 that offered a complete solution starting from the schematic phase up to 
the construction and bid phase. Unfortunately they disappeared after a while, but the same developers 
introduced me to Sketchup. Still dealer of many other BIM and CAD programs I was hooked on Sketchup 
because pretty soon I discovered how easy it was to use it as a tool to conceptualizing my projects, 
present them, and even create construction documents. 

 

You are a leading software instructor at college and private level. Please share your experience 
with our readers. 

After a while I was using Sketchup as a modeling tool I began to teach at college level in an interior design 
program. For my surprise I discovered that many students had problems to understand a 3D space, 
manage the scale of a project, and show their vision to others. As a designer you get used to envision an 
idea, draw it, share it, review it, and create a virtual prototype. But this process that is unconscious in 
most of us need to be learned by design students. Sketchup is the perfect tool to accomplish this learning 
process and help them to understand the scope of their proposals. 

People love beautiful spaces. Most of them they want their homes and workplaces to uplift. We spend most 
of our time in indoor spaces. The field of interior design addresses these desires. The designer's ideas 
must be explained before they can become a reality. Visuals are created to help people understand and 

How Sketchup is useful for interior design and space planning? What version of Sketchup is 
most suitable for interior designing? 
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buy an idea. However with time, I discovered that the meaning of Interior Design have different scopes in 
different countries and cultures. My goal is to reach any professional that impacts interior spaces, from 
architects to decorators. The open-source programs open opportunities for the democratization of design. 
Sketchup Make is aligned with this concept. If you want to step up with a good presentation there is no 
doubt the Pro version is the way to take. 

 

As an interior designer, you may have completed several projects. Which project gave you 
complete satisfaction in which you applied Sketchup successfully? 

I have a unique way of delivering my services. I do collaborative design, a new way of practice that blurs 
the boundaries between designer and customer. My clients are active participants in the design process 
and ideas generation. I use Sketchup as a communication tool to help them visualize their inspiration. I 
am a facilitator that bridges the knowing with their doing. I get great satisfaction from all my projects 
because I can use Sketchup to create a great experience and engage their emotions. Most of the time I do 
not end with a WOW presentation because my clients are not passive consumers. My ideas do not need to 
convinced anybody or sell anything; I work with the inner creativity that most people have without 
knowing that they have it. 

You have written several books on Sketchup and among them which book is most popular 
among Sketchup lovers. Please tell us something about your upcoming books? 

The most popular ones are the first, second and third courses that teach the basics, the 
components/groups concepts, and how to create materials and textures in Sketchup. Although in my 
personal opinion the most valuable information is in Course 4 and in Designing Kitchen with Sketchup. 
They cover a variety of concepts, tips and tricks that usually are not covered in other books and broaden 
the real potential that Sketchup has for interior spaces designers. I just published Sketchup for Interior 
Design Revisited Course 1,2 and 3 that are updates to version 2013 including a few more exercises than 
the previous editions. Right now I am in the middle of updating Course 4 and I hope next year to publish a 
compendium of exercises and case studies for Interior Design. 

What types of improvements/additions should be included in Sketchup in near future? 

I would like to have a native organic tool that could be more flexible than the Sandbox. Also have an easy 
photorealistic rendering engine where I could manage indoor lighting and reflections in a way the Shadows 
tool works for exteriors. I know that there are a bunch of rendering plugins but normal people do not have 
powerful machines that can produce a rendering in a very short time. Neither they want to spend a lot of 
money buying multiple applications for the sporadic needs that sometimes designers have. Most of the 
time we need to be productive and we don't have too much time to generate a photorealistic rendering. 
Sometimes renderings can take us more time that even all the conceptualization of an entire residential 
project. I know that I am dreaming too deep! 
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What advices do you want to provide for newbie interior designers? 

Designers are visual communicators. My best advice would be to use the tools that are available to them 
such as Sketchup to elevate the look and functionality of living spaces. 

 

I wish I could have more time to do something meaningful for them. Most of the people love children, but 
elderly people are usually neglected. All of us we share the same faith, we were born, we grow, but 
inevitable we will age too. If I can do something to mitigate the pain of abandoned people I think that my 
life will have a purpose at the end. 

In your free time you design eco-friendly jewelry prepared from nuts and seeds to support a 
community program for neglected elderly people. Please say something about that. 

What are your suggestions about our magazine? 

I have seen a constant growth not only in your content but also in the amount of readers. I am very 
pleased to see enthusiastic professionals that believe in the potential of Sketchup as I do. 
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Top 10 Apps for Architects 

 

Following our readers poll last year, here’s an updated list of what we think are the best ten apps for architects. From 
condensed versions of large scale programmes architects and designers use every day, to blank canvases to scratch ideas 
down onto, you might just find an app that could improve the way you work. 

1: Paper (iOS) 

With five tools and a blank canvas, coupled with as many virtual sketchbooks as you want, Paper is one of the most loved 
mobile sketching apps. Having won Apple’s App of the Year and been given the 2012 Apple Design Award, the app has 
also been extensively reviewed by The Verge. It’s fast, easy, and responsive. 

http://vimeo.com/37254322#embed 

2: MagicPlan (iOS/Android) 

MagicPlan is, well, magic. It takes advantage of the devices camera and augmented reality to create floor plans of rooms. 
All you have to do is stand and point your device and it does the rest of the work. You can then export these drawings as a 
PDF, JPG, or DXF. It takes a bit of getting used to at first but, once mastered, is quite accurate. 

https://www.youtube.com/watch?feature=player_embedded&v=DMv82x96oK8 

3: Graphisoft BIMx (iOS) 

Introducing Hyper-models – Graphisoft’s term for describing BIM on mobile devices – has the potential to make BIM even 
more popular. As an app that can be used by every member of a project’s design and construction teams, it’s worth 
checking out. 

https://www.youtube.com/watch?feature=player_embedded&v=ze3y6dqqsXs 

4: Sketchbook (iOS) 

This app (designed by Autodesk) offers you sketching freedom coupled with useful ways of exporting drawings on different 
canvas sizes and at different resolutions. It might feel as user friendly as our #1 app choice, but it’s certainly useful. 

https://www.youtube.com/watch?feature=player_embedded&v=Bjr6YWdaTHE 

 

http://www.fiftythree.com/paper�
http://vimeo.com/37254322#embed�
http://www.sensopia.com/english/index.html�
https://www.youtube.com/watch?feature=player_embedded&v=DMv82x96oK8�
http://www.graphisoft.com/bimx/�
https://www.youtube.com/watch?feature=player_embedded&v=ze3y6dqqsXs�
https://itunes.apple.com/us/app/sketchbook-mobile/id327375467�
https://www.youtube.com/watch?feature=player_embedded&v=Bjr6YWdaTHE�
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5: Adobe Ideas 

 

(iOS) 

This app gives a few tools to jot down ideas quickly and efficiently. It doesn’t provide as many export options as our #4, but 
does work well on both iPhone and iPad. 

6: Morpholio / Morpholio Trace 

 

(iOS) 

The Morpholio Project is really interesting and offers an insight into where skilled app designers can go with a good idea. 
Trace is an architect’s best friend and they offer an app that does just that – you can read an ArchDaily review of it here. 

http://vimeo.com/37254322 

7: Autodesk Formit (iOS/Android) 

As a subsidiary of Autodesk Revit, this app allows you to create and alter BIM models on mobile devices. 

https://www.youtube.com/watch?feature=player_embedded&v=TEGFU5q3wjo 

 

http://www.adobe.com/uk/products/touchapps.html�
http://www.mymorpholio.com/�
http://www.archdaily.com/276327/ad-app-guide-morpholio-trace/�
http://www.archdaily.com/276327/ad-app-guide-morpholio-trace/�
http://vimeo.com/37254322�
http://autodeskformit.com/�
https://www.youtube.com/watch?feature=player_embedded&v=TEGFU5q3wjo�
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8: iRhino 3D 

 

(iOS) 

Using this app you can view any Rhine 3DM file on your mobile device. It’s a great way of showcasing your models. 

9: AutoCAD 360, formerly AutoCAD WS (iOS/Android) 

Get all your CAD plans on a mobile device. It’s simple and easy to use. They do require a ‘Pro’ subscription for some 
features. 

https://www.youtube.com/watch?feature=player_embedded&v=7sSsZiHfFl0 

10: Photosynth (iOS/Windows) 

If you’ve ever been on a site, or in an interesting location, and are bored of flat panoramas then this app holds the answer. 
It’s user friendly and, once you’ve stood in one position and circled for a while, it stitches a collection of photos together and 
gives you a great 360degree panorama. 

https://www.youtube.com/watch?feature=player_embedded&v=-ZkGVkFEx3o 

http://www.rhino3d.com/ios�
https://www.autocad360.com/products/mobile/�
https://www.youtube.com/watch?feature=player_embedded&v=7sSsZiHfFl0�
http://photosynth.net/about.aspx�
https://www.youtube.com/watch?feature=player_embedded&v=-ZkGVkFEx3o�
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What can strategic planners learn from architects? 

 
Strategic planning processes createlarge, detailed documents,but often little action. They sit in the bottom of draws or in 
unused electronic files only to be accessed when the next strategy plan is needed. As Dilbert famously described a 
conversation between the head of strategy and a new recruit – “The planning process involves making Powerpoints for the 
executive committee meeting”. “Oh … but that can be fun. I enjoy doing the analysis for Powerpoints.” “Well, actually we use 
the ones from last year and change the dates.” 

Since a strategy is a design for how the organisation is going to compete and what it will do in the next period, maybe 
strategists can learn something from a profession where design is the core skill – architecture. 

One of the things that I have learnt from architects is the concept of “levels of design”, a notion that the creation of a design 
goes through a series of levels of increasing complexity and detail. 

When an architect designs a new house, for example, he or she does it in stages of increasing detail. At the first level, she 
sets out a few basic principles that she and the client agree on. These may be broad visions such as the house should feel 
welcoming for guests or it should blend into its environment. As well as practical details like the kitchen should face East to 
catch the morning sun or the car port should be close to the kitchen to help unload groceries. 

At Level 2 the architect draws a rough sketch of the building. It might include a basic plan for each floor, a plan of how the 
building might sit in its plot and a view from each side. It might also include some basic infrastructure ideas such as the type 
of heating and where the main water and sewage pipes will run. 

Level 3 is a scale blueprint with accurate measurements of each room, details about the heating and plumbing, suggested 
positioning for the main bits of furniture and some important material choices, such as clay roof tiles or a wood floor in the 
living area. 

Level 4 is the quantity surveyor’s list of materials and quantities: the number of clay tiles needed or the yards of copper wire. 
Final decisions are made about power points, about the taps in the bathroom andthe colour of the kitchen wall. These 
decisions are often delegated to lots of different specialists: the interior decorator, the plumber and the garden designer. 

Level 5 involves the many issues that come up as the new house is being built. An extra power point is needed for the wi-fi 
router. The chosen wood fired burner requires a bigger alcove than planned. A supplier is late. The building regulator 
requires thicker floor joists. 

This concept of five levels of design, could be helpful to strategic planners. If planners thought about“five levels of strategy”, 
theymight be less likely to find themselves with fancy plans and little action. The typical strategic planning documentwould 
be recognise for what it is – a rough sketches at Level 2. Before anything is likely to happen, the strategist will need to make 
sure that plans are developed at Levels 3 and 4. 

A Level 3 planwould identify the main organizational units responsible for different parts of the strategy and the operating 
model that links these organisational units together. For each unit, the planspecifies the outcomes expected, the 
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timeframes, the way the unit will work with other units, any constraints on the unit and the resources available. The sum of 
outcomes at Level 3 will achieve the objectives defined at Level 2. 

A Level 4 planspecifies the people, the money and the time needed for each sub-task within each unit.It also explains how 
units will continue with existing activity and take on the extra tasks required by the strategy. 

Just as the work of the quantity surveyor often throws up issues for the architect to resolve, so too will Level 4 plans raise 
issues to be resolved at Levels 2 and 3. Strategic planning should, therefore, includean iterative process for dialogue 
between levels. This requires a concept of levels of strategy, and clarity about the work at each level. In the military, the 
dialogue process is called back briefing. Interestingly, in strategy work, we do not have a good label for this activity. 

Finally, Level 5 planning is about the inevitable adjustments that need to be made as events unfold. The money is not 
available when expected. Critical people leave with little prior notice. The competitor reacts aggressively to the plan. The 
chosen software package does not provide some needed management information. 

Sometimes events cannot be handled by adjustments at Level 5. Changes are needed at Levels 4 or 3 or 2. This is when 
clarity about levels is again helpful. Knowing when events require a Level 5 or a Level 2 response ensures that managers 
do not wander off course unnecessarily or fail to correct course when circumstances demand it. 

Maybean awareness of levels of strategy work will bridge the gap between strategy and action and help organisations do 
better strategic planning. It can’t easily make things worse. 

Andrew Campbell is a Director of Ashridge Business School in the UK and runs executive courses such as Designing 
Operating Modelsand Advanced Organisation Design. He has written more than 10 books on business strategy and 
organisation. 

  

http://www.ashridge.org.uk/�
http://www.ashridge.org.uk/dom�
http://www.ashridge.org.uk/dom�
http://www.ashridge.org.uk/aod�
http://www.ashridge.org.uk/andrewcampbell�
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Designing Operating Models - Fact File 

 

This workshop is about how to design your business. The focus is on operations and how to link operations to strategy. For 
example, we will help you design a TOM (target operating model) that will deliver the business strategy. The workshop will 
help you identify changes you can make to the existing operating model that will open up new strategic possibilities. 

The overall objective is to give you tools that will help you transform ... through higher margins, increased sales or both. 

Who is it for? 

You currently have a role in a business improvement, strategy or advisory function. You may be a member of a Lean team; 
managing projects as part of a Transformation team; a business architect or strategist in Operations or IT or Planning. You 
may be a consultant or an analyst in Business Improvement or Process Excellence. You may be a strategist or business 
partner in HR or IT. 

Whichever of these roles you have, you want to ensure that your operating model is efficient, innovative and aligned with 
your business strategy. You want to better understand the operating model of your business, and have more influence over 
the major choices made. 

You may have been involved in incremental improvements, and are now looking for more transformational improvements. 
You may know how to deliver change projects, and now want to help decide which projects to initiate. You may be an expert 
in Lean methodologies, and now want to be more strategic in the changes you make. You may be doing design work for IT 
or HR or Finance, but want to contribute to the broader business design. Importantly you will feel that you have something to 
contribute as well as something to learn. 

• Six hours of structured preparation: four hours to read assigned articles (we 
also offer an online test that helps participants confirm that they have 
understood the reading); two hours to prepare a case study and participate 
in an online discussion of the case (this helps participants orient their 
thinking to the topics of the workshop) 

The workshop has four parts to it: 

• Two-day residential workshop 
• Conference calls one month and three months after the workshop to share 

experiences and continue the joint learning 
• Finally, PA Consulting and Ashridge will continue to share their learning in 

this area with regular updates on insights into business design. 

http://www.ashridge.org.uk/Website/Content.nsf/wOPN/Designing+Operating+Models~Timetable?opendocument�
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The workshop is run jointly by Ashridge Business School and

The link between Ashridge and PA Consulting 

 PA Consulting Group, combining their respective strengths in 
research, teaching and practice. Ashridge is strong in strategy and business models, as well as related issues such 
as organisation design andstrategy execution. PA brings experience and practice in business design, in developing and 
implementing operating models and in delivering transformational change. 

This workshop is an opportunity for both Ashridge and PA to share knowledge and explore the issues organisations are 
facing right now. Our shared ambition is to develop better insights, frameworks and tools for managers involved in business 
design, business model innovation, business improvement, end-to-end process design and target operating models. 

• The difference between a

Your learning outcomes 

Operating model design is a developing field. Some frameworks and tools are well established, but some are still evolving. 
We will discuss the well-established tools and explore new ones. You will learn about: 

 business model and an operating model 
• The design process, in particular how to turn business strategy into design principles by 

clarifying capabilities 
• Tools for documenting business strategy in a way that is helpful for operating model design 
• Financial analysis tools, such as the Dupont Model, for linking operating model choices to 

financial outcomes 
• Tools for challenging the status quo and encouraging innovation 
• Frameworks for thinking about technology 
• Tools for checking the robustness of new designs particularly organisation structure and 

relationships with suppliers and business partners. 

Since this is a workshop, we will all be learning together. Hence, your learning will depend, in part, on the other participants. 

 

  

http://www.paconsulting.co.uk/business-challenges/business-design/?cm_sp=hpcarousel-_-BusChallenge-_-BC2BD�
http://www.ashridge.org.uk/Website/Content.nsf/wOPN/Strategic+Decisions~Fact+File?opendocument�
http://www.ashridge.org.uk/Website/Content.nsf/wOPN/Advanced+Organisation+Design~Fact+File?opendocument�
http://www.ashridge.org.uk/Website/Content.nsf/wOPN/Making+Strategy+Happen~Fact+File?opendocument�
http://www.ashridge.org.uk/Website/Content.nsf/wOPN/Designing+Operating+Models~Business+Model+and+Operating+Model?opendocument�
http://www.ashridge.org.uk/Website/Content.nsf/wOPN/Designing+Operating+Models~The+Design+Process?opendocument�
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Sefaira introduces first real-time energy analysis software for building 
design 

LONDON and NEW YORK – 30 October 2013 -

Redefining building design with Sefaira for SketchUp – the first software to integrate energy analysis directly into 
the design process. 

 Sefaira, the leader in software for high performance building design, today 
announcedSefaira for SketchUp, a SketchUp plugin that provides architects with real-time energy analysis without leaving 
their native design environment. Sefaira for SketchUp’s interface shows at a glance how a design is performing, and helps 
designers connect the dots between building design and energy use while guiding them towards the best measures for 
enhanced performance. It requires no expertise in energy modelling, and performance-enhancing decisions about form, 
orientation and façade design can be made in seconds. 

Sefaira for SketchUp delivers immediate and constant feedback on a design’s energy use, including information about the 
elements of design that are most responsible for poor performance, all directly in SketchUp while the architect is designing. 
The energy flows graph details the end uses of energy such as heating, cooling, lighting and appliances. It also shows 
graphically the heat gains and losses from the building, enabling the designer to make the right decisions and attain building 
performance targets. 

Leading Architecture Firms Validate Sefaira for SketchUp - Over the course of the development period, Sefaira has 
made Sefaira for SketchUp available to a group of early adopters for usability testing. 

“We can’t think of a reason why we shouldn’t be using Sefaira for SketchUp on every project from day one,” said Till 
Scherer from AWW Architects. “Being responsible for rolling out our innovative approach to sustainability called 
Performance Driven Design, I am excited that Sefaira for SketchUp will allow all our architects to fully understand the 
implications of their design decisions in real time, helping to deliver truly sustainable solutions from inception. Sefaira for 
SketchUp allows the designers to analyse their ideas and explore realistic alternatives, all without lengthy meetings or costly 
iterations.” 

“That instant feedback we get with Sefaira for SketchUp is what we've been waiting for,” said Jennifer Preston from BKSK 
Architects. “Now designers can finally test performance over various iterations. To ask for a building simulation to test even 
three or four scenarios on a facade has always been prohibitively expensive. Now it's something that can happen so fluidly 
that we can do hundreds of tests if we want to -- in the matter of a day.” 

Sefaira for SketchUp Enables Architects to Create High Performance Buildings - Sefaira CEO Mads Jensen said, 
“Our vision is that every architect conducts performance analysis right from the start and that building performance becomes 
a key design driver on the same level as aesthetics and building functionality. Our customers tell us that the biggest 
historical challenge has been the need to leave their native CAD environment and change their design process when doing 
energy analysis. Sefaira for SketchUp is an immersive tool that makes performance analysis an intuitive part of the design 
process, not forcing the architect to add complexity to the process, but seamlessly integrating performance analysis in the 
process the architect is already using.” 

Availability - Sefaira for SketchUp is now available to Sefaira customers and is the first in a series of exciting 
announcements from Sefaira. For more information and to see Sefaira for SketchUp in action, visit www.sefaira.com/sefaira-
for-sketchup. 

About Sefaira - Founded in 2009, Sefaira produces cloud-based energy efficiency software to help architects design high 
performing buildings. Using Sefaira, architects and other building designers can analyze and compare multiple building 
strategies within a fraction of the time and cost previously required. This includes defining, quantifying, and optimizing the 
energy, water, carbon and financial benefits of relevant design strategies. 

Sefaira has been named to the 2013 Global Cleantech 100, the 2013 Red Herring Top 100 Europe, the 2013 European 
Business Award’s “They Could Be Giants,” and the 2012 Going Green Global Top 200 private companies. The company 
also won Gold at the 2013 Ecosummit award in Berlin as well as the “Green Building Innovation of the Year” award at 
London’s Ecobuild in 2011. It is also a 2013 Red Herring 100 Global Award finalist. Sefaira has offices in London and New 
York. 

SketchUp is a registered trademark of Trimble Navigation Inc. Sefaira is a registered trademark of Sefaira Ltd. All rights 
reserved. 

http://www.sefaira.com/�
http://www.sefaira.com/features/�
http://www.sefaira.com/sefaira-for-sketchup�
http://www.slideshare.net/Sefaira/sefaira-for-sketch-up-use-cases�
http://www.sefaira.com/sefaira-for-sketchup�
http://www.sefaira.com/sefaira-for-sketchup�
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Contact: Kelly A. Murray 

kellyamurray@comcast.net 

+1 978-660-1716 

  

mailto:kellyamurray@comcast.net�
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E-on Software Press Release - November 06, 2013 

E-on Software introduces Vue 2014 xStream and Infinite 

I'm excited to announce the immediate avalability of Vue 2014 xStream and Infinite, the latest and greatest generation of 
Vue products for CG Professionals. 

With physically accurate sunlight and photometric lighting, FBX import, Multi-layer 32-bit OpenEXR 2.0 support, World Point 
Position passes, .FBX and .CHAN camera exchange as well as many workflow and interface improvements, Vue is more 
than ever the go-to solution for digital nature environments. 

Make sure you do not miss the latest Vue 2014 videos on youtube: 

Vue 2014 + Nuke Tutorial: 

https://www.youtube.com/watch?feature=player_embedded&v=xC4-N8oPQoA 

Animating Plant Factory plants in Vue 2014: 

https://www.youtube.com/watch?feature=player_embedded&v=vS8KaemWlSU 

Latest Customer Showreel: 

https://www.youtube.com/watch?feature=player_embedded&v=6JuQumMXgtE 

More videos on our youtube channel! 

You will find today's Press Release further down, and online at:

SketchUp is a registered trademark of Trimble Navigation Inc. Sefaira is a registered trademark of Sefaira Ltd. All rights 
reserved. 

 www.e-onsoftware.com/news 

More information on Vue 2014 is available at: www.e-onsoftware.com/vue 

You can download a press pack (containing boxshots, sample images and logos) for Vue xStream and Infinite 2014 
here: www.e-onsoftware.com/about/press_materials/vue_2014 

Review copies (NFR) will be available in the coming days, so don't hesitate to contact me to get one. 

Enjoy the rest of the week. Best regards. 

 

https://www.youtube.com/watch?feature=player_embedded&v=xC4-N8oPQoA�
https://www.youtube.com/watch?feature=player_embedded&v=vS8KaemWlSU�
https://www.youtube.com/watch?feature=player_embedded&v=6JuQumMXgtE�
http://www.youtube.com/user/eonsoftware�
http://www.e-onsoftware.com/products/�
http://www.e-onsoftware.com/about/press_materials/vue_2014/Vue2014Pro_presspack.zip�
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Contact: Matt Riveccie - Communication manager 

mriveccie@e-onsoftware.com 

 

  

mailto:mriveccie@e-onsoftware.com�


 

18 | P a g e  
 

Augment Reality and Sketchup 

 

Augmented Reality is the latest technology that combines real world with digital world in real time. In this system a 3D model 
is superimposed on a video feed for producing illusion to ensure that the model is a material object in the real world. 

Augment Reality provides huge benefits to the architects as they can bring the 3D models and combine them with video 
recording and present to the clients by positioning them to the real world. 

The users should require a webcam, a printer and have capability to export any 3D model into obj, .wrl or .ase formats. As 
for example, if the users make a 3D model in Sketchup, 3ds max or other 3d modeling softwares, they can have a glimpse 
of it on their desk. The users can transform any 3D model in the real world by incorporating Sketchup (free download), an 
Augmented Reality Plugin (free trial version), and a webcam. 

Augment Reality can be applied with a website, presentations, sales pitches, video games and lots other. 

Augment Reality can acquire information from what we observe encompassing us and cultivate valuable information from 
the internet. We see this type of application with Layar. Layar is a browser used for Android Phones which obtains the GPS 
location of the user and draws information concerning that area and superimposes it on top of cell phone camera feed of the 
user. The utilization of Augment Reality is also found with Google Goggles. Google Goggles is an application for Android 
Phones through which the users will be able to surf the web with the photos already snapped on your mobile. In order to 
apply it, just open the Goggles app on your phone, snap a photo of that picture, and get search results all about it. 

There are lots of plugins based on Augmented Reality. ARmedia is the most wonderful plugin for Trimble Sketchup. The 
Development Lab of Inglobe Technologies has developed this plugin. 

With ARmedia plugin, the sketchup users can envisage their 3D models beyond the digital workspace directly on their 
desktop as well as in the real physical world encircling them by linking through a webcam and by printing an appropriate 
code. 

By applying the Exporting feature, the augment reality files can be generated and distributed separately and envisioned on 
any computer with the freely accessible AR-media™ Player. The process can also be executed if the sketchup as well as 
ARmedia plugin is not installed. The users will be able to produce their own SketchUp™ Augmented Reality models and 
allocate them to their clients as autonomous, stand-alone files and allow their clients experience such models in Augmented 
Reality. 

• Analyzing scaled virtual prototypes in real surroundingss 

The AR-media™ Plugin comes up with a highly developed visualization functionality which brings the following 
benefits: 

• Transmit 3D projects immersive and surprisingly 

http://layar.com/�
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In order to activate AR-media™ Plugin, the users should require a individual computer, a webcam and a printed code 
affixed to the software. Various types of Head Mounted Displays, including eMagin, i-glasses™ are also supported. 

The latest version AR-media™ Plugin v2.3 was released in September 2013. It is free and compatible with both Windows® 
XP/Vista/7/8 as well as Mac OS X 10.5 and later (Intel). 

Download the latest free version 

AR-media™ Plugin v2.3 for Trimble SketchUp™ for Windows® XP/Vista/7/8 

AR-media™ Plugin v2.3 for Trimble SketchUp™ for Mac OS X 10.5 and later (Intel) 

• Exporter for Android devicesNEW - The users can now generate .armedia files which can be 
demonstrated applying AR-media™ Player for Android. Notes 

Key features available in the most updated version: 

• Video objects support for iOS and Android devices: AR-media video objects are now 
presented in iOS Player and Android Player. Go through the notes for getting more 
information. 

• Geo-located models for iOS and Android devices: The users can now utilize iOS Playerand 
Android Player to show virtual models in the real world devoid of any marker. 

• Exporter for iOS devices: Now onwards the users will get the ability to produce .armedia files 
which can be showed with AR-media™ Player for iOS. Notes 

• Chroma key videos: The users can start videos formed with the chroma key technique (both 
green and blue screen is supported) like textures on your 3D objects. 

• Linked Markers: Now the users can present a solo model on two or more markers with the 
chance for showing the same object with diverse viewpoints. 

• Layers' Management: The users can position entities on dissimilar layers and display them 
separately throughout the AR visualization. 

• Timed Slideshow: The users can arrange their 3D contents as the same as a set of slides. In 
reality, each layer will be shown for a selected time interval and then substituted with the 
following layer. 

• Shadows: For getting a more practical visualization, the users can arrange the sunlight in 
SketchUp™ to spread shadows on 3D objects. Besides, the users can interrelate with this 
light source in real-time, changing it and altering the shadows' visualization. 

• Clipping/Sectioning: With this functionality, the users make sections of 3D objects in real-time. 

Tutorial – Quick and Easy Augmented Reality from SketchUp 

 

  

http://www.inglobetechnologies.com/en/new_products/arplugin_su/download_app.php?version=win32�
http://www.inglobetechnologies.com/en/new_products/arplugin_su/download_app.php?version=macosx�
http://www.digitalurban.org/2007/07/tutorial-quick-and-easy-augmented.html�
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Kitchen rendering with Sketchup, 3dsMax+Vray & Photoshop 
Hi everyone, I’m Mark Lester Ocampo and a Designer / 3D Visualizer based here in Bahrain. Today via Sketchup-Ur-Space 
I’ll explain how I created my kitchen rendering with Sketchup, 3dsMax+Vray & Photoshop. 

 

It is a good practice to ALWAYS conform to real-world sizes; in this case I used the metric system of measurement. 

Modeling 

Modeling process starts with Sketchup, with the nature of my current work, I try to cut as much time as possible in the 
modeling process so I decide it would be best to start the basic shapes in Sketchup since I noticed that I’m faster using it 
than 3dsMax. 

 

Once I finished modeling the basic shapes, I’ll export it to 3ds file then import inside 3dsMax. But we need to define first the 
scale of our model inside 3dsMax, I used millimeters. 
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At this point, once we imported the 3ds file inside 3dsMax then we will start modeling the kitchen doors. 

 

Below is the door profile: 
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With these references, I was able to model the profile from scratch, I used sweep modifier to follow along a line and make 
the whole door: 

 

Texturing 
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The kitchen door’s texture were done manually by me, I managed to get an actual sample from the supplier and scanned it. 
It’s a big piece and will not fit my scanner so I decided to scan by areas and will join it in Photoshop. 

In Photoshop, open all the scanned images then go to File > Automate >Photomerge 

 

 

Here’s my setting for the wood texture: 
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Note: I put a bump and reflection map by isolating the red channel of the diffuse map in Photoshop and made it a new file 
as seen on the second material editor. 

Lighting 

For the lighting, I used VraySun+Sky for the external lighting and added some VrayPlanelIghts in every opening I see with 
Skylight Portal set to ON. My settings are shown below: 

Vray Sun: 
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Vray Plane Lights placed in every window 

Additional Lights 

In addition to the Vray Sun, I added another Vray plane light pointing at the window opening which in my opinion can help 
simulate a studio lighting ambiance to my scene; it’s positioned with the same axis as the Vray Sun. 
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I have another Vray Plane Light near the ceiling at the far end corner of the scene which acts like a studio softbox. 

 

Another one is positioned at the hallway to counter-balance some dark areas of the scene. 
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Camera Setting 

Rendering 

I use gamma 2.2 and Bruteforce when rendering, it’s very slow but so far reliable. 
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Below you can see my Render Elements, notice that I used two different Ambient Occlusion passes linked by two separate 
VrayExtraTex. The first one makes sure that I get the AO on the smaller details while the second ensures that I get the AO 
for the overall scene. 

 

Post-Production 

I made some minor adjustments in curves and levels to make the contrast “pop”. 
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Below you can see how I masked the reflection+filter / refraction+filter passes and how I used the two AO passes. After that, 
I duplicated another copy andapplied Auto tone and Auto contrast with 50% opacity then merged it. 

I Used VrayRenderID to isolate each parts of this scene with “Color Range” tool and copying the selected area to another 
layer and individually sets different adjustments as shown below: 

 

You may have noticed before that I did not put any background in 3dsMax because I did it in post-production, in order to 
isolate the window opening, I used alpha channel and tweaked my glass material to appear with the alpha render element. 
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Next is to create a “Bloom” effect, this will simulate the light leaking out of the window due to the sun’s light streak. Duplicate 
a copy and desaturate it, go to curves and make something similar to this adjustment: 

 

Now go to Filter > Blur > Gaussian Blur and set Radius to 22 pixels. Change the layer to “screen” with 20% opacity. 
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To add a subtle sharpness to your image, Duplicate another layer then go to Filter > Other > High Pass and set radius to 0.7 
pixels, change layer to soft light. 

 

Next we will simulate Chromatic Aberration, I used a plugin “PTLens” to do this, it’s easy to use and it comes with a lot of 
simulated lenses to choose. you can download the trial version here: http://www.epaperpress.com/ptlens/download.html 

http://www.epaperpress.com/ptlens/download.html�
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I did some minor adjustments again this time with Color Balance: 

 

Finally, I used another plugin “Color Efex Pro” to simulate a “cross processed” look same of what you see with old film 
cameras. 
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We’re done! See the difference between the RAW render and the final output: 

 

Before 

After 
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Thank you. I hope you’ll find my tutorial helpful and a great addition to your workflow. Good luck and happy rendering! 

  



 

35 | P a g e  
 

How to make a halfpipe with Sketchup 

 

Google sketchup is a google product that was designed as a 3-D modeling program. I will show you how to use it to make a 
halfpipe 

 
This is the step shows what the base of the ramp will be 

2: Making it 3D, Putting Some Life Into it 

1: Platform 
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here is what to do to make it 3-D. You will use the push/pull tool and the curve tool. 
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3: Delete the Lines 

 

there should be one vertical line on each side, use the erase tool to delete them if something bad happens stop and go to 
edit>undo erase 

4: Coping 

 

This is how to make the pipe that is on the edge. 
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5: Copy and Paste 

 

Make the other half, this step uses the rotate tool, line draw, and move tool. 
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6: Finishing Touches 

 

Finish it up! you will use the paint tool, and the mouse tool. 
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And Done! 
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How to make Unique Shapes in Google SketchUp8 

The key to making a unique shape in SketchUp8 is the “follow me” tool. It can be found under tools in the toolbar. The first 
step is to make any two dimensional profile, a square, a triangle, a polygon, a circle. Next make another profile, intersecting 
it with the first profile. The profiles can be similar; however, to make a unique shape try using a different type of profile like a 
circle and a triangle. Use the pointer to click on one surface of one of the profiles, and then using the “follow me” tool click 
the other surface to begin making a shape. To exaggerate, a circle and triangle will make a cone; two circles a sphere, to 
rectangles a cube. To make a unique shape try using the “follow me” tool without first clicking the surface of any profile, try 
to use an angled profile intersecting with a surface oriented profile. 

To make a unique shape you essentially need to make two profiles and simply use the “follow me” tool. The “follow me” tool 
is very powerful, after guiding the mouse through the screen you can come up with very unique shapes and make virtually 
anything. I strongly recommend using this on any project done in SketchUp8. 

https://www.youtube.com/watch?feature=player_embedded&v=CfQZMY-IK4Q 

 

 

  

https://www.youtube.com/watch?feature=player_embedded&v=CfQZMY-IK4Q�
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LightWave 11.6 and NevronMotion Final Releases Now Available 

The LightWave 3D Group, a division of NewTek, Inc., has made available the final release of LightWave 11.6 software for 
3D modeling, animation, and rendering. In addition, the company announced today the final release of the NevronMotion 
plug-in for LightWave 11.6, which uses the Microsoft Kinect camera to capture motion in real time for retargeting to 3D or 
live-performance characters. 

NevronMotion also simplifies retargeting data from standard motion capture files directly into the LightWave interface. 

LightWave 11.6 introduces new features for modeling, animating, capturing, retargeting, and inputting and outputting to 3D. 

Animate in New Ways: With the Spline Control tool, nulls or other objects act as nodes in a spline to control or deform 
objects such as tentacles, tails, whips or even elevators; Raycast Motion utilizes raycasting technology to make an animated 
object aware of its surroundings;, and the Compound Node feature can simplify complex networks down to a single node. 

Streamline Real-Time Virtual Production, Pre-Viz, and Game Development: Use NVIDIA CgFX shader technology to create 
3D assets for virtual production, pre-visualization, or game development and view assets within LightWave OpenGL exactly 
as they will appear in the final real-time display engine. Users can also place Normal Maps on 3D objects to make lower-
polygon objects or characters display as higher-resolution objects, and create custom CgFX shaders or use existing CgFX 
shaders. 

Output to 3D Printers: LightWave Modeler now includes new import and export options to support the popular STL and PLY 
file formats. VRML is also supported and offers surface color data for 3D color printing of objects with texture maps. Also 
included is full control of the export format used, whether in ASCII or binary, the up direction, and units for export. New 
geometry clean up tools specifically for 3D printing output are also included. 

Review in Full Stereoscopic 3D: With support for NVIDIA 3D Vision, 3D Vision Pro, and HDMI stereo devices, artists and 
designers can visualize high-quality advanced stereoscopic 3D environments across multiple devices, including enabled 
desktop monitors and multi-projector wall displays. 

 

TheNevronMotion plug-in for LightWave 11.6 extends the software's Virtual Studio Tools to: 

• Capture live-rig motion with the Microsoft Kinect camera 
• Retarget motion capture directly in LightWave Layout 
• Save and adjust captured motion data from the Kinect camera 
• Easily adjust arm and leg mocap positions and layer hand-keyed animation on top of motion 

capture files 
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• Save and load retargeting presets for FBX, BVH, or custom setups 
• Preset rigs for Kinect and motion capture formats 
• Quickly bake out motion to character rigs 

LightWave 11.6 is priced at $1,495 and the NevronMotion plug-in is priced at $299. Registered LightWave 11 customers 
can upgrade to LightWave 11.6 free of charge; upgrade pricing from LightWave 10 or earlier versions is $695. Educational 
pricing is also available. 
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King Students Utilize Minecraft for 3D Modeling Education 
Students at King High School will be taking part in a 3D modeling educational journey, using creativity and critical thinking 
skills to create an interactive learning environment based on a historic event. 

And get this -- they will be using the help of a popular video game called Minecraft. 

"There's an inner kid that wants to start building stuff, and this is the way to reach into it, because it has everything a person 
likes," student Rudy Mata said. "Video games, building, fun with friends. Anything you want." 

"This is just a great way to start learning how to build, animate on the computer," student Lee Muro said. 

It's called the King High School Minecraft Project. Over the next several months, students in King's Digital Technology Class 
will embark on an educational journey using ideas based on the popular video game. "Rez Day," as they call it, are the first 
steps students will take towards virtual reality integration in the classroom. 

"Part of the TEKS for this class is virtual spaces, 3D environments, and I wanted to find a virtual space that would be good 
to work with kids in the classroom," teacher Katherine Hewett said. "And right now the students are crazy about Minecraft." 

It's all about making learning fun, and introducing these bright young students to the latest technology. 
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Philadelphia University to Use LumenRT for GeoDesign 
e-on software, the leader in 3D Immersive Nature technologies, recently announced that Philadelphia University has joined 
the LumenRTLuminaries program and has adopted LumenRT as part of its core GeoDesign graduate program. 

The Philadelphia University GeoDesign program is the first of its kind in the United States, applying GIS technologies to 
solve sustainable design problems in response to an overwhelming need for professionals in the field. Visionary GeoDesign 
professor and former director of enterprise GIS for the City of Philadelphia, James Querry leads student work with advanced 
technologies including GIS, workflow modeling, 3D modeling, BIM and innovative visualization techniques while they help 
develop and test new tools that inform future industry software. 

"We are excited to be working with e-on software and LumenRT as part of our MS in GeoDesign curriculum," explained Jim 
Querry, professor of landscape architecture and GeoDesign. "The real-time, 3D immersive visualization capabilities of 
LumenRT provide a seamless and engaging mechanism to showcase design and planning projects." 

"Philadelphia University is leading the way forward for advanced GeoDesign studies and we enthusiastically support this 
cutting-edge program," said David Burdick, vice president of marketing at e-on software. 

"We look forward to helping Philadelphia University advance its state-of-the-art 3D GeoDesign studies and train the next 
generation of innovative minds serving this growing field." 

 

  

http://www.lumenrt.com/�
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Chenderit School's first 3D Print 

Last week we brought you a blog from Anna Marriott, a teacher at Chenderit School who acquired a Cube for their Design 
and Technology course at TCT Show 2013. She talked us through the difficulties of getting the printer through the various 
bits of red tape. Now it is up an running and here she talks us through the students’ first 3D printing project. 

After the difficulties we faced getting the 3D Systems Cube printer through the minefield that is bureaucracy we now have 
SketchUp and the Cube software installed on some pupil computers. It is time to start the 3D printing adventure at Chenderit 
School. 

The mission we’ve set the student is to use 3D modeling software and 3D printing to create small merchandise products for 
a Year 9 Movie Marketing module. Over the course of this module students have come up with their own movies and 
designed a range of products to promote said movie. 

We’ve allowed the students’ creativity to flow and informed them that only the most suitable designs would be printed out 
using the Cube. 

Some of the students have now mastered the basics of SketchUp and have created some very interesting designs in the 
fairly simple to use software. The next challenge was exporting from SketchUp to Cubify and then printing. This is a unique 
situation as both the teacher and the students are learning as we go along. 

Cubify is the software which comes with the Cube. It loads quickly and easily. Following the straightforward instructions on 
the software is a breeze. There are the following actions, which we figured out pretty quickly: 

Import - find the file - done! 

Heal - seals any gaps - we think – done! 

Orient and scale - This seems a bit trickier? Not sure how this works, but we’ll try it to see. Settings say mm so we’re 
guessing that the grid base equates to the print plate of the cube? 

Centre 

 

Now to build and load it onto the memory stick ready to print off. Loading the Cube is impressively easy, you just have to 
follow the touch screen instructions! Print time for the trial shape was one hour and three minutes so let’s print! 

- obvious - done. 
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Learning the Landscape Through Reverse Engineering Projects 

The undergraduates in my Introduction to Education course at MIT are conducting observations and writing blog posts about 
their experiences. I'm reposting here a post from Jennifer Liu, who has some insightful observations about a Google 
SketchUp project in the engineering course she is observing. 

Ms. O is generally hands-off when it comes to hands-on projects in her engineering class. For the first few weeks that I 
visited her classroom, her students worked on "reverse engineering" projects in which they selected everyday objects from 
their lives, created digital 3D models of them using the SketchUp software, and wrote up specs for them. 

This project highlighted a few effective learning practices: 

Open-ended learning - Students could choose whatever objects they wanted, as long as no two chosen objects were the 
same (in order to prevent copying). There were no other boundaries. This gave students the freedom to model something of 
interest or importance to them, as well as the opportunity to weigh different options for close investigation. 

Technological exploration - Students were given little guidance on how to use the SketchUp software, provided with the 
opportunity to "learn the landscape" by figuring it out on their own. This aspect enhanced the open-ended learning 
experience--without step-by-step instructions for how to use the software and what to create, students were free to play 
around with different features and experiment in what could be considered a "playground for learning." According to Ms. O, 
students were already familiar with core features of SketchUp after a few days of working on their projects--clicking, 
dragging, creating, and modifying objects like experts. This was apparent when I visited--most students were efficiently 
working away independently on their computers. If they struggled to replicate a certain feature at any point, they would 
consult the documentation, then seek help from the teacher or nearby peers. Being comfortable with using computers and 
figuring out how to perform certain tasks on them is a critical skill in our modern age of technology. 

In addition, the reverse engineering project also exercised important engineering skills: 

 

Observational/dimensional analysis - Required to reproduce objects through another medium, students were forced to 
observe and measure their objects more closely than they would otherwise, from all different angles, inside and out. 

Mathematical intuition - One time, a student--let's call her Janie--asked me why one circle on her model looked so much 
bigger than one beside it, even though the radius was only double that of the other. Janie was convinced that she had 
modeled something incorrectly. I responded by grabbing a pen and pencil and asking her if she remembered the formula for 
the area of a circle. We derived the areas of her circles based on the radii together to find that the bigger one should in fact 
be four times the size of the other. This realization on her part was reached through a process of guided discovery and 
learning-by-doing. Without measuring the circles on her original object and reproducing the object on SketchUp, Janie likely 
would not have drawn the connection between the radii and size of the circles. 
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Communication of specifications - By going through the process of writing specs, students practiced their communication 
skills and descriptive abilities. This forced them to pay close attention to detail and convey their findings through words, an 
important skill for engineers working in teams. 

Of course, benefits are usually countered by risks. The opportunity to engage in open-ended, independent learning was not 
embraced by every student at all times. Some with limited attention spans were often caught surfing the web or watching 
YouTube videos, resulting in a harsh scolding by Ms. O, who seemingly has eyes that cover a 270-degree range (perfect for 
monitoring the 30-something students sitting in front of computers against the wall on three sides of the room). Some 
students also required a little extra push to get going, which I noticed was often provided by nearby classmates who showed 
them the ropes through their own projects or pointed them to potentially helpful buttons. Once students were tipped on the 
right track, however, these projects seemed to offer them an enriching, multifaceted learning experience. 
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Using Guides in Sketchup 

With the Tape Measure tool, you can create an infinite guide line in SketchUp that allows you to use the power of the 
Inference System to snap to. I use guides all the time in my model to help me model accurately. But I also find myself 
creating “custom guide geometry” in order to help me place objects that are difficult to inference. In this post, I’ll show you 
how to create your own guide geometry. 

If you don’t know about the Tape Measure tool, you should. It’s a great way to create a special type of line called a guide 
line that you can snap to in your model. I use them all the time when modeling. I’ll add a few in order to position an object, 
then delete them right after I’m done using them. Other times I’ll just leave guides in the model till I get overwhelmed with 
dashed lines everywhere,at which point I’ll go to the Edit menu and select “Delete guides” to get rid of them all. 

But recently I’ve realized a need for a custom guide to help me position handles on some cabinet models I was working on. 
The way I used to place handles is I would position the handle at the corner of the door. From there, I’d move it to the left 2″, 
then move it up 3″. I was doing this for every handle, then realized there’s must be a better way! 

https://www.youtube.com/watch?feature=player_embedded&v=XFvR4BvLbQo 

Custom Guide Geometry : The Tape Measure tool produces a special SketchUp object called guide lines and guide 
points. What I’m talking about when I say “custom guide geometry” is creating regular SketchUp entities, but USING them 
as if they were guides. They aren’t meant to be shown in the final render or export of the model, they are only used to help 
assist in placing and aligning objects. 

Custom guide geometry are lines or shapes that you group with another object in order to aid in the placement of 
that object. 

In the case of the cabinet door handles, I simply created a set of rectangles that intersected at the point I wanted to offset 
from the corner of the door. So now instead of positioning the handle by snapping from a point on the handle, then offsetting 
left and then down, I was positioning it by snapping the guide geometry to the corner of the door. Done! 

I assigned the guide geometry to a special Layer called “guides” that I can hide whenever I’m not positioning something. 
The key to creating guide geometry is how you organize the group/component. I used a component for this handle because 
I knew I’d need a bunch of them throughout my model. Inside the “Handle” component, you have the guide geometry in a 
group (assign this to the “Guide” layer), and the handle geometry in a group. 

By combining the guide geometry and the object geometry into a group/component, you can move the entire collection as 
an assembly. But you can assign the guide geometry to a different layer in order to hide it when you don’t need it. 

 

To create your own guides, you’ll need to be creative. Use a combination of lines or rectangles in order to create points that 
you might commonly use to offset placement of an object. I like to color the guides brightly so I can easily identify them. Also 
take advantage of mid point inferences. On the cabinet door handle, I included a line connecting each square, that way I 
could snap to the mid point of the drawer front. 

Here are some examples of where you can create custom guide geometry to help you place an object. 

https://www.youtube.com/watch?feature=player_embedded&v=XFvR4BvLbQo�
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• Pipes/cylinders – Place an “x” at the centerpoint of the pipe to make it easier to reference. 
• Electrical outlets - Create a special component for each height outlet you need to place. 

Reference the floor with your guide, position the outlet at the correct height from the floor. 
• Toilets/Bath Tubs/Fixtures/furniture - Pretty much any oddly shaped object can take 

advantage of using guide geometry. Create the geometry to have the correct offset from the 
wall for a standard installation. 

• Windows/Doors - Reference the floor with guide geometry to locate window heights. You 
could also create a component that only had guide geometry in it that represented heights of 
different components in your model (outlets, switches, windows, doors, etc.) Place one of 
those components on each wall for easy referencing when placing objects at the correct 
height. 
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Magazine Details – The Creative team of Sketchup-ur-Space 

 

Started in September 2010, Sketchup ur Space (SuS) was the first online magazine devoted to SketchUp, that 
unique, innovative 3D design tool from Google. It holistically covers features, events, news, updates, reviews 
and many tips and tricks. 
 

 

Rajib Dey: rajib@sketchup-ur-space.com 

Rajib, the editor-in-chief of SketchUp ur Space magazine is the main writer. He is 
responsible to write the cover story, blog and many other columns. Along with it, He is 
creating a liaison between the writers and the readers. 

 

 

Manoj Kumar Singh: manoj@jobs2india.com 

Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in 
the html version. Manoj is the html developer who beautifully creates each and every 
edition with care along with the PDF version. 
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